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GetSolar Overview

Purpose of GetSolar

(&) Bosch Solar Simulation

@ BOSCH

Elbsc

> GetSolar is a computer software tool for simulating residential and
commercial Solar Thermal Systems quickly and effectively

> The software aids in the sizing of both collector arrays and water
storage volume for DHW, Space Heating, Pool Heating, and Combi

Systems

BOSCH
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Sizing Options

> 2 Options:
« Wizard
« Streamlined process for quickly sizing an application with
minimal details and at default system settings
o System Parameters (detailed system setup)
« More comprehensive methodology with ability to add and
change the various parameters of the system giving a more
accurate system design

BOSCH
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Methodology for Using GetSolar

> Best method:

« Step 1: Use the wizard to get an initial estimate for the number of
collectors, total storage, and solar fraction

« Step 2: Go through the system parameters menus and make changes
where applicable

« Step 3: Simulate the system and analyze the results

« Step 4: If necessary, go back and optimize the system by altering the
various parameters including number of collectors, tank volume, and
system type

> Rules of thumb:
« 1.5 gallons of storage per 1 sqft of collector surface area for DHW
« 2 gallons of storage per 1 sqft of collector surface area for DHW + Space
Heating
« Set the collector angle near the latitude angle of the project location for
DHW only and add 15 degrees to the latitude for Space Heating

BOSCH
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Overview (Home) Screen

Bosch Solar Simulation

Fle  SIMULATION Extra

T | s wiizard a4 Simulation

»

Basics

2 Collector

Project:
location:

Collectaor:
Limension:
(Characteristics:
Mourting angle:

ISystem type:
Tank:
tempersture:

recuired energy:

ISolar heating:

Solar thermal combi system

Wizzhington (0C) latitucde: 38.9°

Bosch FKC-13

T2ET 2

etal = 0770 al = 3681 Wim*K) a2 = 0.0173Wim=K=)
4500 Azimuth: 0.0°

Combined tank for DHW and Space Heating
198 Gal solar tank (144 + 52 gal domestic- and heating water)
max. 167°F ! min. 126°F

28.58 kbtuiday = 42 galiday from S0°F to 131°F
34.14 Mitulyear heating energy
at T amb. = 59°F heating circuit: 131/104°F, 24 kbtuh at 3°F

System
Layout

Project
Details
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Project Details

> The project details at the overview
screen include:
— —— « Dimension: Total square footage
&“,—" Ch e of collectors
R « Collector Characteristics:
s 55 . eta0: conversion factor
Sty o . al: heat transmission
coefficient
« a2: heat transmission
coefficient

BOSCH
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Wizard

(&) Bosch Solar Simulation

File  SIMULATIOMN Extra 2 -~

Basics

ﬁ Maomenk

Simulation

”
! Collector
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__> The Wizard may be accessed
from any window by clicking the
“Wizard” button on the top left

BOSCH
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Wizard
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> Clicking the Wizard button will
bring up this screen. The
following options are present here:
« Project Name:
« Enter the project name here
« The project name can also be

entered and edited by going to
“File” -> “Project Info”

"~~~ Location:

« Select the location either by
scrolling through the list or
typing in the name

BOSCH
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Wizard: Collector Details

__> Collector Type:

e « Select the type of collector for

] the system

o p—— e « Both portrait and landscape for

T —— FKT-1 and FKC-1 collectors are

provided

> Collector Orientation:

* « Enter the slope and azimuth
values at which the collectors will
be simulated

« Note: the red collector image and
the triangle changes as the
azimuth and slope values are
altered

-~
-~
-
-~

BOSCH
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Wizard: DHW Only

Domestic water a6 galfday

Hot water termp. 125 °F

~
- -
-
-~

-~
-
-~

a1 kbtu/day 10516 kbiufvear] N

OBolar Cornbisysterm N

Package option d
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Enter parameters regarding the
system itself

Domestic Water:
« Total DHW load in gallons/day
Hot Water Temp:

« Desired hot water supply temp,
typically 120 degrees F for DHW
only

The two boxes below these show
the total kBtu required per day and
per year

BOSCH
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Wizard: DHW / Space Heating

_.» Solar Combisystem:

] « Clicking this button brings up the

5| e Pt g parameters for Space Heating
o el __-> Heating Energy Demand (building
ol Corrbisysier — - - o -7 -7 heat IOSS) :

——— e o b7 « Enter the space heating energy

demand in kBtu/year

-~
-~
-~
-~
-~
-~
-~
-~
~ -~
-~

T. limit for heating s op

. o Sum of the DHW and space
Ve heating load

11

“~» T. Limit for Heating:
« Warm weather shut-down

BOSCH
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Wizard: Heating Energy Demand

7

7/

E? GetSolar - Help

12

& A

Hide: Back Horme
Contents I Indes: | §earch1 Fadl*

Tﬁ GetSolar - Help
+ Q Legal information
+ @ Wizard
+ @ hbzin menu
+ @ Project data
+ @ Calculation moce
+ @ Location
= m System
5 @ System type
[7] Thermal disinfection (ar
+ @ Temperstures f Demand
Solar heating

& o z

; = 7
Frint  Options 7

/7
4
4

GetSolar calculates the relation between the solar yield Lpzﬁ for heating in solar con
requirernent. This value has to be given here. p

For systems with a heating water tank, the annuallhgating energy can be matched w
button [>>]. It calculates the annual heating engpgy resulting from the nominal heatir
annual course of the outside termperature at the chosen position.

/7
LAnnual heating energy = Living Space (B3 Heat requirement [REHWIRA
Climate Zones

Zone 1 | Zone 2 | Zone 3 | Zone 4 | Zone 5

@l.ﬂ.nnual hesting eneray

R Valiie ot building Average heating energy requirement

@ Heating circuit
@ Hesat exchanger - 2r
@ Connection with the
5 @ Swvitnming pool
+ @ Back-up
+ @ Collector
+ @ Addiionsl functions

kbtu/ft* per year

No insulation 45 30 23 14 5
Poor 32 21 16 10 4
Good 16 11 8 LS} 3
Very good £l B 5 = 1
Excellent B 4 & 2 1

Impeortant: Depending on intemal heat sources and passive solar energy gains, the
heating power can be much smaller than might be expected from the installed power

TT/SNA-EAP3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.

A table with heating requirements
is provided in the help section and
may be used as a reference for
estimating the space heating
requirement if unknown.
Location:

o Help -> System -> Solar Heating

-> Annual heating energy

Climate Zone Map:

« http://www.eia.doe.gov/emeu/recs/r
ecs97/zonemap.pdf

BOSCH
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Climate Zone Map

U.S. Climate Zone Map

e
ék Climate Zones

el [] 2ene tIsless than 2,000 CDD and greater than 7,000 HOD,

[ ] Zone 2 isless than 2,000 CDD and 5,500-7,000 HOD.

[] Zore 3 s s than 2,000 GDD and 4,006,498 HOD,
I Zore 4 ks lss than 2,000 CDD and less than 4,000 HDD,
I 7ore 5 15 2,000 D or mare and less than 4,000 HOD,

13 BOSCH
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Wizard: DHW Results

> This window displays a graph with

] the annual solar energy gained in
Solar energy for domestic hot water FKC-15 1 fu” year

Annual graph Kbty Cirnension

2 = =l 3> Onthe right of the graph is the
' total gross square footage of the

F 25000
L 20000 \
Solar fraction

w0 collectors

. > Also displayed is the solar fraction
+. provided by this system

Clows I i > If this is a DHW only system, then

the total water storage will be

shown in this window along with

the option to select a Bosch

package

BOSCH
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Wizard: DHW and Space Heating Results

> This window is similar to the DHW

IEEEEEssssssesssssssmmmmmmn  only one with the following

Solar energy for DHW and space heating s differences:
. Y R « The total number of collectors
ey e o S increase to accommodate for

o “~._  space heating

% - w n "~ The solar fraction is displayed
R split into DHW and Space

Clonss s \\\ Heating along with the total solar

.

v fraction

15

e The total water storage
requirement is displayed

BOSCH
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Wizard: Results

> At the end of both of the results window, one can edit the number of
collectors used by either clicking on the up and down arrow buttons.

> Once the desired result is met, click the OK button to exit the wizard
and save the system

> The system will now be saved in GetSolar and is ready either be
edited further or simulated.

> After clicking the OK button, GetSolar will proceed to the Home
Screen displaying the new values and sizing

BOSCH
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System Parameters

() Bosch Solar Simulation > System Parameters:

ile  SIMULATIOM  Exkra * . . .

- } . o Basics: include overview,
’ moment, and simulation
/.« Position (location): position,

105 I | Wizard g Simulation -~ shadow (shading), WetSyn data
A (meteorological data)

" /,’/ . System: System type,

Wy ol /,’ /,/ temperatures/consumption/tanks,

Simlatian o // space heating, pool, and back-up

— . .. Collector: collector type,
: o It parameters, solar circuit

J Collector ¢ |--7

17 BOSCH
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System Parameters: Basics

_> Overview: General overview of the
project

Moment: System data and
performance at a specific instant
of time

Simulation: Detailed analysis of
the system including full project
report for distribution to customer

Y10 | s wizard g Simulation -

| Collector

BOSCH
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System Parameters (Basics): Moment

Action shot of the collector

~

Time

* Today - 10/24
" Spring " Eall
" Summer O Winter

Collector action shot 10/24 /12:00 PM h
529 h after sunrize

highest sun elevation: 3947
Azimuth sunseti-rize: +-74.8°

Elevation at 12:00 h: J94° Azimuth 12:00 b 2.5°
A

10024

= direct light: 254 6 ktui(hr- 1) (TL =3.5)
1 s diffuse light:

insolatign en = 1ft* T3 ft2 [cos | =0.99]

I
TET,
iy
- == = direct:
Turbidity factor 3.5 - diffuse
AEE [l — ' global:
T —— T 1]

253 3 btuithr-f2) 185 kbtuh
36.3 btuithr- ) 2.7 kistuh
2901 btuthr-1%)  21.1 kbtuh

Mounting angle: 45.0° Azimuth; 005 T T T e e

-——
-
-
-
-

tor power 15.4 kbtuh
< Efficiency: T4% at ambiert temp.:  68.0°F

Return 68 - F feed temp.: 921°F temp. difference: 241 °F

return temp.; 63.0°F Tcol-Tambient: 12.0°F
Stagnation temp,

) - e e e m—_-—
Ambisnt tmp. 58 7 = = = = = =sMRpoaton | 4 collector orientation
_______
T. amb, as probable - - v Lo
Collector always oriented to the 60°
4

sun position | —5— |

30°
Angle 45 2

M o] =1 W

2 Brint ] ’ Text 53 ] ’ Trnage By

19
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The moment section represents
system parameters and performance
at a certain instant of time

Here the reference time is selected
Turbidity factor is used to determine
how much of the suns rays are
passing through the atmosphere and
reaching the collectors

Clicking the T. amb as probable option
uses the average ambient air
temperature values of the location.

BOSCH
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System Parameters (Basics): Moment

_> On the right side are details of the

systems performance including the

Collector action shot 1024/ 12:00 PM h fo I | OWi n g i nfo rm ati O n :

+ Today - 10/24 £20 h after suntise

" Spring " Eall ) ; : H H
s e « Elevation and azimuth of the sun
s i encs el -
r J— Elz‘\:nations:tnfzDﬂnﬁf3 3940 Azimuth 1200 b 2.5% ® COSInus Of the angle between the Sun
] e, Eoom e and the vertical of the collector (Cos
' J O insolation on 1ft* T3 ft2 [cos | = 0.99] I)
fh direct: 2533 3 btuithr-1%)  15.5 kbtuh
L talgliy iay 38 dtfuse oAb ) 27 ketuh . . . ..
Ji : . gid . =
o T { Lr L TR S o Direct light = irradiation on a plane
— - — - Efficiency: T4% &t ambient temp.;  63.0°F . . .
! - feed temp.: 921°F  temp. diff T 241 °F
s o907 T Tamn 130 vertical to the direct light

Stagnation temp,

Ambient t2mp. 68 F 1 sun position 4 collector atientation [ ] D iffu Se I ig ht = d iffu Se I ig ht 0 n th e

(il::t:r:;:;::femedtothe ’ 60 horlzontal plane
- . = « Irradiation on 1m?2 of active collector

surface-Irradiation on the whole
e | | tord J{ i active surface of the collector

« Collector feed temperature

« Collector stagnation temperature

20 BOSCH
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System Parameters (Basics): Simulation

21

B Start

[ WetSyn ] [ Options ]
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~_> Graph and table displaying system

efficiency, solar fraction, and solar
fraction for DHW only throughout
a given time period of either 1 or 3
years

Clicking either the start or
continue button begins the solar
calculation

The results button displays the
details of the simulation including
savings in energy throughout the
year

BOSCH
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System Parameters (Basics): Simulation Results

o > Theimage on the right is the

o] e el results window that pops up after
Project: Solar thermal combi system

\ocatmn:. Washington (DC)  latitude: 35.9° D o

I S L. the calculation has completed.

Mounting angle: 45.0° Azimuth: 0.0°
Systarn type: Combined tank for DHW and Space Heating Eco balance

This window is broken down into

required energy. 28.58 khtwday = 42 gal/dayfrom 50°F to 131°F

34.14 Mbtuivear heating energy Tent 153
Solar heating atTamb. < 59°F  heating circuit: 131/104°F, 24 kitwh at 3°F — fo u r ta bs .
) ) Text2 23 *
Month solar Solar solar backup  Solar fraction efficiency
yield heating * irradiation energy  dhw heating
[kbtu] [kbtu] [khatu] [kbtu] [%] [%] [%] E b | .
January: 1084 714 2507 174 38 9 43 ® nergy a anCeo
February: 1357 1017 2860 167 et} 16 47 Image 1
March: 1703 1340 3439 176 37 26 a0 M
e e e e 2 o Details on the system
hay: 1056 a 3769 ] 101 a 28
June: 1002 1) 36gg 1 93 1) 27 . .
July: 1043 0 3749 B 99 0 28 f I t b t
woust doe7 0 a3 0w perrormance, solar contrioution
September: 954 a 3499 12 93 a 27
Octoher: 1438 934 3293 104 61 a4 44
Movemher 1200 i1 2380 184 32 21 51 and baCk-up usage both
December: 916 596 2040 179 34 9 45
Total: 14406 B454 38367 1144 BT 149 a8

factor of savings for sdhw and space heating: 31.3% month Iy and an n u aI Iy

specific annual collector vield: 198 kbtuft

Daone

BOSCH
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System Parameters (Basics): Simulation Results

» Eco-balance:

et (e e st o « Details on monthly and annual
| Toaion Wasningion ©G) " Iattude: 38 - [oem ] .
e 5 e energy savings and CO2

Systern type: Combined tank for DHW and Space Heating (4) Eo bl .
required energy. 2893 kbtu/day = 42 gal/day from 50°F to 131°F 150 [FE1EINEE)
34 14 Mhtutvear heating energy reductlons

Salar heating: atT amhb. = 53°F heating circuit: 131/104°F, 24 kbtuth at 3°F
COIV. Energy: Gas-fired condensing boiler
fuel utilization eff;  88%J 77% [ B3% in winter i spring, autupn § summer
Month s_olar energy C02_—

yield saving saving

khiu therm Ibs

January: 1084 1128 ih 133
February: 1357 1423 15 187
March: 1703 22 22 7
April 1598 21454 22 264
May: 1086 1675 17 208
June 1002 1691 16 135
July 1043 1656 7 203
August 1047 1662 7 204
Septemhber: 954 15815 15 186
October: 1438 1993 20 245
MNovermnber: 1208 1570 16 183
December. 916 1052 11 129
Total 14406 18731 197 2421

Done

). (&) BOSCH
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100%

a0%

6%

System Parameters (Basics): Simulation Results

energy balance | eco-balance EﬁraDhS I gurvesl

A

Text 153

40% [ F—B—

20%

Text 2 53

1
(]

\}M"

Image 1 B3

7
i
o
s
gl
'P
')
’D
i

Image 2 By

Jan Feb Mar Apr May Jun Jul  Aug Sep Oct Mo BC erage

@ Efficiency Solar Fraction dam. hot water Solar fraction tatal (F sav)

jw]
=]
=]

@

24
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o Graphs:

« Graphical monthly breakdown
of solar fraction for DHW, solar
fraction for Space Heating and
efficiency

BOSCH
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i
h
1409 L /R 1Al | L NI R :
Text 153
N

oF I Text 2 53

System Parameters (Basics): Simulation Results

Curves |
Il 1] S )

v| Solar yield

I ro0 Eco balance

50

IMage 1By

-
Jan Feb Mar Apr May Jun Jul Aug Sep ©Ock Nov Dec - Image 2 B

‘Year

(]

mm v Solar systest povwer
Zoom out ¢ i
[ Q\Iertor temperature
-
(| temperature tank 1, upper

-
| [nsolation on collsetor

¥ B v temperature tank 1, lower
mm v temperature tank 2, upper
a vear 2 [ B v temperature tank 2, lower

Done
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\
\
\
\
\
Y

o Curves

« Graphs showing the
temperature ranges for the
different points of the system.

« Can be zoomed in or out to
show graph for yearly, monthly
and even daily values by
clicking the zoom in and zoom
out buttons

BOSCH
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150

o0

50

w! termperature tank 1, upper
! ternperature tank 1, lower
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Project Report

2> Once the simulation results have

been confirmed, the project report
may be created. This is done by
clicking on the print button at the
top right of the results window.
The report may be 1 to 3 pages,
depending on whether the Eco-
Balance and/or Solar yield
selections are chosen or not.

BOSCH
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Project Report

> The top half of the first page
shows the system layout along
with a summary of the project
Project information parameters.
o > If selected in the print options, the
sounpicis L = e header details will be displayed,
- [ e along with company logo

0.0° Azimuth
Solar heating

atTamb. < 59°F
heating circuit 131/104°F

combined tank

198 Gal solar tank

288 + 103 gal

(domestic- and heating water)

Gas-fired condensing boiler

BOSCH
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Project Report

> The bottom half of the first page
has the annual results for the

Results

required energy Hot water and storage heat losses 25190 kbtu/year re q u i re d e n e rgy S OI a r fra Cti O n
heating energy 34144 kbtulyear 9 b
Total 59334 kbtu/year .

Solar fractions f‘om._hotwaier gggz}’u an n u aI Solar yleld 9 and energy
faita:rng? savings for sdhw and space heating 48.59’:

.
Key values Efficiency %glﬁ;mm? S av I n gs

specific annual collector yield
based on the collector gross area

solar yield dom. hot water 16369 kbtu/year
Heating 12429 kbtu/year
Total 28798 kbtu/year
eco balance energy saving 39724 kbtulyear
397 therm
CO2 reduction 4874 Ibs/Year

The results are being calculated using a mathematical model. The actual solar output and energy savings may differ from the

model due to variations in weather, patterns of use and other variables. The shown system schematic is for illustration only.

It does not substitute the design and specification of a solar thermal system by a qualified engineer. Before implementing the

design, all assumed parameters that have led to the results of the pre-design simulation should be checked against the actual
design parameters. The responsibility for carmying out this check rests with the designer, installer, developer or customer.

© 2010 Bosch Thermotechnology 10/25/2010 5:26:28 PM - page 1

28 BOSCH
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Project Report

Header: adresse, name etc. can be entered here (<File> <Print options>)

Bosch Solar Simulation 2.0.11 - energy balance -
Project: Solar thermal combi system
location: Washington (DC) latitude: 38.9°
Collector: 14570 ft* (5 pes.) Bosch FKC-1S
Characteristics: etad = 0.770 al=3.681 WAmM*K) a2 =0.0173 WAm*K®) [Solar Keymark]
Mounting angle: 450° Azimuth: 0.0°
System type: Combined domestic- and heating water tank
Tank: 198 Gal solar tank (288 + 103 gal domestic- and heating water)
max. 179°F / min. 123°F
required energy: 62.63 kbtu/day = 100 gal/day from 50°F to 125°F
34 14 Mbtulyear heating energy
Solar heating: at T amb. < 59°F heating circuit: 131/104°F, 19 kbtw/h at 3°F
Meonth solar Solar solar back up  Solar fraction efficiency
yield heating © irradiation energy ** dhw heating
[kbtu] [kbtu] [kbtu] [kbtu] [%] [%] [%]
January: 2084 1449 5013 1419 3 19 42
February: 2563 2077 5718 1456 25 33 45
March: 3219 2617 6875 1462 29 51 47
April: 3140 1841 6969 821 64 81 45
May 2247 0 7535 47 102 0 30
June: 2112 0 7373 1 98 0 29
July: 2237 0 7496 17 100 0 30
August: 2230 0 7355 5 100 0 30

29 TT/SNA-EAP3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.

> The second and third pages show
system details, energy/eco
breakdown monthly and annually,
and a graphical representation.
The second page is specific to the
energy balance (solar yield) and
the third page for the eco-balance
(energy and CO2 savings). These
are the same tables and graphs
from the results sections.

BOSCH
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System Parameters: Position

= |~ wizard
Basics

R e

B
“ [Maorment

Sirmulakion

Position
Shadaw

WetSyn data

v Simulation _> Position: Details on the location of

" the project

_> Shadow: Window for adding
shading

_.> WetSyn Data: Meteorological data

J collector

BOSCH

TT/SNA-EAP3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.




GetSolar Overview

System Parameters (Position): Position

31

2000 [\Washington (D)

L4M-L4N  Barrie . ~CDN

T1H-T3Z Calgary _ s COMN
TaA-TEX Edmantan . - CON
B3H-B3Y Halifax e COp— " v
z —~ =
td -
-
' - — -
| et || ynew ][ 3 peete | I’ -
-
[ "% Eind ] [ %z Sort ] =
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- - °
Puosition parameters -> Position
iy - —
Position | Shadow ‘ wetSyn data ‘ -
postecode |Iocati0n Country -~
33601 Tampa (FL) LSA ” 9
08601 Trentan (M) LSA
85701 Tucson (A7) LSA )
74101 Tulsa (0K Usa  ~

Location window with ability to
pick location in the scroll down
menu

Ability to edit cities, add new
cities, and delete cities

Multiple ways to locate specific
location including by scrolling
down the menu, searching
through “find”, and sorting using
“sort”

BOSCH
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System Parameters (Position): Shadow

4

32

Position  Shadow ‘ﬂetSyn datal

a0

60

30

-
-
-
-
-
-
-
-
-
-
-
-
-

-
-
-
-
-
-

Calculate with shading | Dtewimage | | ElInsert ohiect
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The shadow window allows for the
input of shading and locations of
where projections of objects will
be present

The graph provides a visual of the
location of the projections at the
center of the collector array

The “Calculate with shading” box
must be checked in order to
including shading in the simulation

BOSCH
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System Parameters (Position): WetSyn Data

Position parameters -> WetSyn data

Positian ‘ Shadow  ¥etSyn data

kbbuf(Ftz d)

P

Jan Feb Mar Apr

348
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0.5

Fosition:

File:
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Qoo
[V VI

Jul Aug Sep Oct MNov Dec

Washington (DC)

(5 Load

allli, e Wt Syn
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> WetSyn data is the meterological

data used for determining amount
of solar radiation hitting the
collectors at the specific location

BOSCH
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System Parameters: System

NS H| Wz g gmutation > System type: Variety of system

Basics 2 ’
Vs
7
— 3 /
Cvervisw s
7
v
Maomenk /
s
Sirmulation ,/ ,/
7 7
s 7
¥ ,/
7
Vs
R /
%
7
Vs
System type / —
/ -
J - / - - -
Temperatures | Cons 7,

Saolar heating . i

-
- =
——

—
—
——
——
=

Swimnming pool

Back-Lp

Collector
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layouts to use specific for the
project
Temperatures/Consumption/Tank
s: Inputs for the system loop
temperatures, DHW load, and
tank sizing

Solar heating: Specifics for solar
heating

Swimming pool

Back-up

BOSCH
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System type

System Parameters (System): System type
_> System type

o Mu|t|p|e options available to meet

Temperatures § Consurnption f Tanks ‘ Solar heating ‘ Swirnming pool ‘ Back-Up ‘ -
-’

the most common system
= applications
> System Layout

y « Visual depiction of what the
system layout looks like

3 mmmm |- System specific options

™ Solar DHYY dual coil tank
" Solar DHYY - Combi-boiler

" Solar preheat system

L}

&+ Combined tank for Solar DHW and space heating

" Dual tank systern for DHW and space heating

35

e —— /,/" o Options may include back-up
& Tarcintank — r type, swimming pool, or anti
legionella

BOSCH
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System parameters -> Temperatures / Consumption / Tanks

Systemn type  Temperatures f Consumption f Tanks

-
Solar hieating ‘ Swirnming pool ‘;Elad(UDT

TermperatLres
Cold water inlet

Hot water outlet termp. 131

Maximum temp. 167

T. limit for heating period 59

g -

°F

-
Cansurnptiop——"="
-

-
- Hot water 28 58 Klatu/ckary
kbtu -» gal

Dernand profile
|N0rma| profile j

¥ Change ” G Mew ” =5 Delate ]

Tanks 198 Gal solar tank

Capacity 144 gal D

(Heating water part)

36

Capacity tank 2 52 gl

(Dormestic hot water part)

Insulation 189 (ft2=Fhr )bty
awerage J_ good

TT/SNA-EAP3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.

System Parameters (System): Temperatures/Consumption/Tanks

> The temperatures for the collector
loop, tanks, and control strategies
are located on the left hand side of
the screen

~> The consumption section allows

for changes in DHW load and
DHW demand profile for daily and
annual usage.

> Tank options vary based on type
of system selected, with ability to
change tank volume and
insulation factor

BOSCH
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System Parameters (System): Temperatures/Consumption/Tanks — Demand Profile

&) pemand profile

Mame hormal profile

Daily pro E ]Iear\v prafie |
|
|
| 0-6Bh B-12h 12-18h 18-24h
1 2 Ik : 7 7 4
- -
! 0 3 5 g | -
|
s s &
| am. 0 P M.
| [%] 0 7 [%] 3 5
! o 7 a 3
|
I o 10 s 2
|
| o
I -
! L
|
| e e s )
" 0 5 1z 15 24h P
L e e e e e e e e e e e e e o o o P /_ —_
| [sum: 100 r

\

> The demand profile may be
customized to be more specific to
the project
_- > Daily profile values can be
changed in this window. Ensure
that all values sum up to 100
___ If not, the graph will be colored in
",:” red rather then blue advise that
the sum is not 100

7’
-

1--> Yearly profile values can be edited

in the second tab

37
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System Parameters (System): Solar heating
_.> Q heating is the input box for the

System parameters -> Solar heating

38

4

System type | Temperatures [ Consumption / Tanks SD_Iar_heating- 'SWanEg pool | Back-Up ‘
Annual heating energy Heating circuit parameters
Q heating 341 Mominal power 242 khtufh

at outdoor ternp, 3 °F
Supply tarmp. 13 °F
Return temp, 104 *F
T. limit for heating period 59 “F
W, =
._ Lt

—_——
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/
/

/
4

Space Heating load in kBtu/year

> Specifics of the space heating
loop including nominal power,
supply temp and return may be
edited on the right side

BOSCH
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7’
System parameters -> Swimming pool

Binimum temperature
in the tank

104 o

39

System type I Temperatures [ Consumption § Tanks ‘ Solar heating  Swimming poal Back—Ug]’
/’
’
Pararneters P
/’

Pool temperature °F PA

Pool capacity 13209 aal

In use from D4j15 | uwntil  [ogj1s
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System Parameters (System): Swimming Pool

_» Window for integrating pool
specifics

BOSCH
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System parameters > Back-Up

System Parameters (System): Back-up

> Menu for selecting and editing the
back-up component of the solar

Systemn type ‘ Temperatures § Consumption f Tanks ‘ Solar heating ‘ Swimming poal  Back-Up ‘

cxktp N thermal system

e wtews w1« - Click the change button to

thar 4N -7 customize the back-up to be more

e WIATITT Sk specific for the project need

s % % e || o > The final report will use these

N values as defined in this section
. for fuel usage, CO2 offset and

savings

BOSCH
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1= |~ wizard

System Parameters: Collector

T > The collector menu is where

Basics

E Crverview
t Momenk

Sirmulation

changes in the collector type,
positioning, and solar circuit are
made.

Collector type: change collector
type and view specific collector

details in this section

Collector

Collector type
Paramekers

Solar circuik

41
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Parameters: input for collector
pitch and azimuth

Solar circuit: specifics for the solar
collector loop

BOSCH
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System Parameters (Collector): Collector type
> Option to select the type of

collector for the system
: . Detalils for the collector may be
e accessed by clicking on the
JERA “Show” button

Pshow | g [k i

BOSCH
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-
-

Collector parameters -> Parameters

Collector type Parameters

Solar circuit

Collector field parameters _- _-
- - =
. = - -
Active surface area 7287 Il’ “ftz .=
-
(3 Collectors) 25 f
-
-
-

A -

Slope 450 -7
-

Azimuth ] a |:_ <

[ East-west collectors
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System Parameters (Collector): Parameters

Change the number of collectors by clicking
the arrows either up or down

The slope and azimuth may be altered also
to meet project needs

« As in the wizard window, the collector
representations on the right alter as the
slope and/or azimuth is changed

There is also an option for simulating
collectors installed East and West

The map option is useful for determining the
azimuth and get an idea of collector location
visually.

« To use, copy the from your computer by
clicking “Print Screen” and then press
the map button. The image will load up
in the map section, where it can be
dragged for placement

BOSCH
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System Parameters (Collector): Solar Circuit

Collector type

Solar circuit

Length

Material

Elow rate

Mediurn

Frost protection until

Wolume share antifreeze
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Parameters Solar circuit

Collector parameters -> Solar circuit

[ 3 +

(single distance tank - collectar)

copper tube - type K

0.020 gpmfft2
L

1.457 gpm

propylene glycolfweater

22 3 °F
47 2 %

> The “...” button provides a sizing

guide for determining the pipe
diameter
Flow Rate:

o FKT-1: 0.009 gpm/ft2

o FKC-1: 0.009 gpm/ft2
The values shown for medium, frost
protection, and volume share
antifreeze are specific to the Bosch
Tyfocor L fluid so should be kept as
displayed

BOSCH
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Daily DHW Load Guidelines

> Residential (Based on Water Flow Rate & Sizing Guide for
Commercial & Industrial Use, Marlo Incorporated):
o 1st Resident: 20 Gallons Per Day
» 2nd Resident: 15 GPD
o Subsequent Resident: 10 GPD
> Commercial (Based on California Solar Initiative Thermal Program
Handbook Rev 3.1):
« Apartments/Condos: Number of units
o 2 to 20 units: 42 GPD
21 to 50: 40 GPD
51 to 100: 38 GPD
101 to 200: 37 GPD
201 plus: 35 GPD

BOSCH

45

TT/SNA-MKT3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.




GetSolar Overview

46

Daily DHW Load Guidelines Cont.

« Student Housing: 15 GPD per unit
Hotels/Motels: 15 GPD per unit

Retirement/Nursing Homes: 18 GPD per room
Office Building without Showers: 1.0 GPD per person
Restaurants:

o Meal Service Restaurants: 2.4 GPD per full meal served

« Quick Service Restaurants: 0.7 Gallons per meal served
Elementary Schools: 0.6 gal/student/day of operation
Junior and senior high schools: 1.8 gal/student/day of operation
Laundries: 20 GPD per 10 Ibs per washing machine

BOSCH

TT/SNA-MKT3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.




GetSolar Overview

a7

Important Notes

> The software must be UN-INSTALLED from your computer before
installing an upgraded version
« To do this follow the following steps
« Start Menu -> Control Panel -> Add or Remove Programs ->
Bosch Solarsimulation US -> Remove
> Following the removal steps
« Install the new version of GetSolar
« Delete all files in the following folder:
o C:\Documents and Settings\SAN1IRV\Application Data\Bosch
Solarsimulation US\
> After completing the above steps, GetSolar is ready for use

BOSCH
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Contact Info

Nishant Saxena Mark Stimson
(TTNA/SNA-EAP3) (TTNA/SNA-MKT1)
Project Manager Product Manager

Bosch Engineering Solutions STS
Cell Number: 949-616-0386 Cell Number: 805-657-4508
Office Number: 949-585-5462 Office Number: 805-456-6468

Email: nishant.saxena@us.bosch.com Email: mark.stimson@us.bosch.com

BOSCH

48

TT/SNA-EAP3 | 9/16/2010 | © 2010 Robert Bosch LLC and affiliates. All rights reserved.




